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Chapter

1 Installing and activating 
RSView32

About RSView32
RSView32™ is a Windows®-based software program for creating and running 
data acquisition, monitoring, and control applications.

Designed for use in Microsoft® Windows Server 2003, Windows XP,  
Windows 2000 and Windows Vista environments, RSView32 contains the 
tools you need for creating all aspects of a human-machine interface, including 
real-time animated graphic displays, trends, and alarm summaries. RSView32 
integrates easily with Rockwell Software, Microsoft, and other third-party 
products to maximize the power of ActiveX®, VBA, OLE, ODBC and OPC® 
technologies.

Determining system requirements
The hardware and software you use with RSView32 depends on the demands 
your project places on the system. The greater the demand, the more powerful 
a system you need.

The recommendations below are based on field experience. It is possible that 
your application will operate on a platform below these recommendations.

In the following tables, the demands your project places on the system are 
represented by points. Total your points in step 1, and then use the table in 
step 2 to determine the hardware and software you need.
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Step 1    Total your points

For If you are Add points

RSView32 
project

running displays, or editing your project using 
RSView32 Works

2

using more than 30,000 tags 2

using more than 5,000 tags 1

changing displays, on average, more than 
5 times per minute

1

using more than 200 objects in displays 2

using ActiveX controls in displays 2

Alarms monitoring more than 1,500 tags for alarms 2

monitoring more than 300 tags for alarms 1

Active Display 
System, or OPC 
simultaneously 
active clients 

using typically more than 5 active clients 2

using at least 1 client 1

Data log or 
historical 
trends

logging less than 100 tags in 1 model 1

logging between 100 and 1,000 tags in 1 model 2

logging to more than 1 model 2

Event detector, 
derived tags, or 
real-time 
trends

using any 1

VBA using any 2

Add-ons using any, for each one 1

Total your points here
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Step 2    Determine the recommended system 
configuration

Important: The hardware should meet or exceed the minimum hardware requirements of the 
operating system you will run.

* With Service Pack 1 or later.

** With Service Pack 3 or later.

*** With Service Pack 1 or later.

**** With Service Pack 1 or later.

***** With Service Pack 2.

For this number 
of points

Minimum hardware 
you need

Minimum software you need

8 or more Pentium® II 400 MHz
128 MB RAM

Windows® XP Professional* or

Windows 2000 Professional** or

Windows Server 2003*** or

Windows Vista**** or

Windows 7 Professional or

Windows Server 2008*****

6 to 7 Pentium II 300 MHz
128 MB RAM

Windows XP Professional* or

Windows 2000 Professional** or

Windows Server 2003*** or

Windows Vista**** or

Windows 7 Professional or

Windows Server 2008*****

3 to 5 Pentium 200 MHz
64 MB RAM

Windows XP Professional* or

Windows 2000 Professional** or

Windows Server 2003***

1 to 2 Pentium 100 MHz
24 MB RAM

Windows 2000 Professional*** 
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Installing RSView32 and the user’s guides
The steps below explain how to install the RSView32 software and user’s 
guides from a CD-ROM to your computer. If you choose not to install the user’s 
guides, you can view them from the CD-ROM.

Installing RSView32 on Windows Server 2003, 
Windows XP, Windows 2000 and Windows Vista
As part of the installation process, RSView32 creates program folders and 
modifies registry entries. In order to make these modifications, the currently-
logged-in user must have administrator rights on the computer on which 
RSView32 is installed.

Installing RSView32
Follow these instructions to install RSView32 on Windows Server 2003, 
Windows XP, Windows 2000 and Windows Vista.

To install RSView32
1. Close all open Windows programs.

2. Place the RSView32 CD-ROM in your CD-ROM drive. The CD-ROM should 
start running automatically.

If the CD-ROM does not start automatically, run D:\SETUP.EXE where D is 
the drive containing the CD-ROM.

3. In the RSView32 window, click the button for the option you want to 
install.

4. Follow the on-screen instructions.

5. During installation, you will be prompted to activate RSView32. If 
activation is present from an earlier version of RSView or RSView32, 
click Next. 

If you removed the activation or if you are installing RSView32 for the first 
time, insert the Activation disk in the diskette drive and click Activate. For 
details about activation, see “Activating RSView32” on page 5.

6. When installation is complete, restart Windows. If you do not restart 
Windows now, be sure to restart it before running RSView32 for the first 
time.
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Installation summary
The default installation does the following:

 installs RSView32 in \Program Files\Rockwell Software\RSView

 adds a Rockwell Software\RSView32 folder to your list of programs. This 
folder contains the shortcuts for RSView32.

 installs the ODBC drivers for Watcom SQL® 4.0 in the system directory of 
your operating system. Only Watcom SQL 4.0 is supported with RSView32. 
Other versions may not function correctly. Check the ODBC Data Source 
Administrator in the Windows Control Panel for version numbers.

Activating RSView32
Rockwell Software uses activation files to activate its Windows-based software 
packages. You can activate RSView32 by using FactoryTalk Activation 
software to download and transfer activation files. 

FactoryTalk® Activation
FactoryTalk Activation provides a secure, software-based system for activating 
Rockwell Software products and managing software activation files. With 
FactoryTalk Activation, there is no need for a physical “master disk” or any 
physical media; instead, activation files are generated and distributed 
electronically.

Important: EvRSI activation is replaced by FactoryTalk® Activation in this release. If you are
using EvRSI activation, please contact your local Rockwell Automation Sales office or Technical
Support for information on migrating your activations to FactoryTalk® Activation. For Rockwell
Automation Technical Support in the U.S. call (440 )646-3434. Outside the U.S. see http://
www.rockwellautomation.com/locations/.

Finding more information about FactoryTalk Activation
You can find detailed information, instructions, and troubleshooting tips in the 
FactoryTalk Activation Help. 

After installing and launching the FactoryTalk Activation software, click Help 
or Learn More . . . to open  FactoryTalk Activation Help.
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Activation keys
The following table lists the activation keys for the RSView32 products.

Using the FactoryTalk Activation Manager
The FactoryTalk Activation tool is used to obtain the activation files needed to 
activate your software. It can also be used to borrow activations from servers 
having available activations, return activations back to servers, re-host 
activations, etc.

This key Is for this product

RSView.D100K RSView32 Works, 100,000 tag database

RSView.D32K RSView32 Works, 32,000 tag database

RSView.D5K RSView32 Works, 5,000 tag database

RSView.D1500 RSView32 Works, 1,500 tag database

RSView.D300 RSView32 Works, 300 tag database

RSView.D150 RSView32 Works, 150 tag database

RSView.D75 RSView32 Works, 75 tag database

RSView.R100K RSView32 Runtime, 100,000 tag database

RSView.R32K RSView32 Runtime, 32,000 tag database

RSView.R5K RSView32 Runtime, 5,000 tag database

RSView.R1500 RSView32 Runtime, 1,500 tag database

RSView.R300 RSView32 Runtime, 300 tag database

RSView.R150 RSView32 Runtime, 150 tag database

RSView.R75 RSView32 Runtime, 75 tag database
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To open the FactoryTalk Activation Manager:
On the Windows Start menu, click Programs > Rockwell Software > 
FactoryTalk Activation > FactoryTalk Activation Manager.

To use the FactoryTalk Activation Manager:
1. In the FactoryTalk Activation Manager, click the Home tab then click Get 

New Activations, or you may click Manage Activations tab, then click Get 
New Activations.

2. Select the Activation Method to be used.

To provide the software’s Serial Number and Product Key, identify the 
activation server’s Host ID, and download activation files, follow the 
instructions in the manager.

3. Save the activation file or files.

Activation files must have a .lic extension. You can save the files to the 
default location:

On Windows 2003 and Windows XP the default location for FactoryTalk 
activation files is:.C:\Documents and Settings\All Users\Shared 
Documents\Rockwell Automation\Activations

On Windows 7 Professional and Windows Vista the default location for 
FactoryTalk activation files is:C:\Users\Public\Documents\Rockwell 
Automation\Activations"

For details, click Help in the top left corner of the page.

Protecting activation files
Activation files are simple text files that must have a .lic extension. The 
activation key for RSView32 is called RSVMSGR.PRO.

As long as the .lic extension is retained, you can copy or rename an activation 
file without harming it. However, tampering with text inside the activation file 
can disable your Rockwell Software products.

If an activation file is damaged or deleted, contact Rockwell Automation 
Technical Support.
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For safekeeping, keep an original set of your activation files on backup media. 
Use descriptive names for the files, so that you can identify them later, and copy 
them back to the appropriate computers.

Activation files are locked to the Host IDs of the computers (or dongles) that 
need them. Activation will fail for Rockwell Software products on a computer 
where the specified Host ID is not recognized by the activation file.

Using borrowed activations
RSView32 supports borrowed activations for development computers. A 
borrowed activation is retrieved from a pool of available activations on the 
activation server, and expires after a specified length of time. Once a borrowed 
activation is checked out to a particular computer, the computer can disconnect 
from the network. When the time limit expires, the associated software on the 
computer is no longer activated, and the activation automatically becomes 
available again from the server’s activation pool. A borrowed activation can also 
be returned to the activation server manually before the time limit expires.

To borrow activations from a server:
1. Connect your computer to the network where the activation server is 

located.

2. Run the FactoryTalk Activation Manager and then click the Manager 
Activations tab.

3. Click the Manage Activations tab, and then click Borrow Activations 
tab.To borrow a single activation, click the checkbox that corresponds to 
the activation you want to borrow, and then click Set Borrow Term. To 
borrow more than one activation, click additional checkboxes for the 
activations you want to borrow and then click Borrow. If you do not see 
the activations you want to borrow, click I Don’t See My Activation 
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Here. The Activations in gray may not be selected as they are already 
borrowed by your computer.
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4. In the Set Borrow Term window, set the time of the return by entering a 
calendar date, net number of days, or approximate hours (shift). The 
default Calendar date is the maximum borrow term for the activation or 
group of activations.

To return a borrowed activation before it expires:
1. Connect to the network and run the FactoryTalk Activation Manager. 

2. On the Manage Activations tab, click Return Activations, select the 
borrowed activations you want to return.

3. Click the Return Activations button.

To open the Activation Help:

To open FactoryTalk Activation Help. Open FactoryTalk Activation Manager, 
click Help or Learn More . . .
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FactoryTalk® Activation Grace Period
FactoryTalk Activation provides customers with access to critical software 
components for a grace period of 7 days regardless of availability of valid 
activations.When a product is successfully activated, all grace period records 
will be cleared and the product will proceed with valid activations.

 During the grace period, FactoryTalk Activation will display a warning 
message box to the user and log a diagnostic warning message to 
FactoryTalk Diagnostics  every four hours if no valid activation key is 
detected.

 Once the grace period expires, RSView32 will enter demo mode. However, 
until RSView32 is restarted, it will continue to run as in the grace period.

 RSView32 Personalized version can be successfully activated with both 
RSView32 Personalized activations and RSView32 Protected activations.

Starting RSView32
You can start RSView32 manually or you can set up RSView32 to start 
automatically when Windows starts.

The steps below describe how to start RSView32 on Windows 2000 or later.

Starting RSView32 manually

To start RSView32 in Windows 
 Click the Windows Start button, select All Programs, (or Programs, in 

Windows 2000), Rockwell Software, RSView32, and then click RSView32 
Works. 

Starting RSView32 automatically
To automatically start RSView32 Works each time Windows starts, include an 
RSView32 Works shortcut in the Windows StartUp folder. You can also open 
a project when Windows starts.

To add RSView32 to the StartUp folder in Windows 2000
1. Click the Windows Start button, select Settings, and then click “Taskbar & 

Start Menu.”
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2. In the Taskbar and Start Menu Properties dialog box, click the Advanced 
tab. 

3. Click Add. The Create Shortcut wizard opens.

4. To start RSView32 Works when Windows starts, browse to the location of 
the RSV32.exe file, and then click the file name. 

The path is \Program Files\Rockwell Software\RSView\RSV32.exe.

5. To start RSView32 Works and open a project when Windows starts, 
specify the path to RSView32 and to the project. For example, to specify a 
project called Norm’s Bakery, type:

“C:\Program Files\Rockwell Software\RSView\RSV32.exe” 
“C:\Program Files\Rockwell Software\Samples\Norm’s Bakery\Norm’s 
Bakery.rsv”

If the path contains spaces, you must enclose it in double quotes.

6. Click OK, and then click Next.

7. In the Select Program Folder dialog box, select the Startup folder, and then 
click Next.

8. Specify a name for the shortcut (for example, RSView32).

9. Click Finish, and then click OK.

For more information, see your Windows documentation.

To add RSView32 to the StartUp folder in Windows 
Server 2003, Windows XP and  Windows Vista
1. Click the Windows Start button and select All Programs.

2. Right-click the Startup folder and select Open.

3. Browse to the location of the RSV32.exe file. 

The path is \Program Files\Rockwell Software\RSView\RSV32.exe.

4. Right-click the file name and select Create Shortcut. The shortcut will be 
created in the same location as the RSV32.exe file.

5. Drag the shortcut into the Startup folder.

For more information, see your Windows documentation.
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Ensuring your system has sufficient virtual memory
Windows uses virtual memory to extend the physical memory installed in a 
computer. It does this by moving information from RAM to disk if the 
information has not been used recently. When the information is required by 
an application, the information is then moved back into RAM. This process of 
moving information from RAM to disk is called swapping.

To guarantee that Windows will have enough virtual memory to run RSView32 
and other applications, you can force Windows to reserve a specific amount of 
disk space for use as virtual memory. While the amount of virtual memory 
needed depends completely on your application and what other programs are 
running, the following recommendations should be sufficient in most cases.

It is better to use a permanent swap file than to use a temporary swap file. With 
a permanent swap file, you specify how much disk space can be used. This 
avoids any disk problems that could occur if a temporary swap file becomes too 
large.

By default, Windows Server 2003, Windows XP and Windows 2000 use a 
permanent swap file, but you can change the size of this file.

To set up a permanent swap file, specify the virtual memory setting.

To specify a virtual memory setting in Windows 2000
1. On your desktop, right-click the My Computer icon, and then click 

Properties.

2. Click the Advanced tab, and then click Performance Options.

3. Under Virtual Memory, click Change.

4. If you have more than one hard drive, select the hard drive you want the 
swap file to be located on. Preferably, this should be the hard drive with the 
fastest access time.

5. Under Paging file size for selected drive, specify 192 MB as the Initial Size 
and 384 MB or more as the Maximum Size.

6. Click Set, and then click OK.

To specify a virtual memory setting in Windows Server 
2003 and Windows XP
1. On your desktop, right-click the My Computer icon, and then click 
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Properties.

2. Click the Advanced tab, and then under Performance, click the Settings 
button. 

3. In Performance Options dialog box, click the Advanced tab.

4.  Under Virtual Memory, click Change.

5. If you have more than one hard drive, select the hard drive you want the 
swap file to be located on. Preferably, this should be the hard drive with the 
fastest access time.

6. Under Paging file size for selected drive, specify 192 MB as the Initial Size 
and 384 MB or more as the Maximum Size.

7. Click Set, and then click OK.

To specify a virtual memory setting in Windows Vista
1. Click the Windows Start button and select Control Panel>System.

2. Inthe left pane, click Advanced System Settings. 

3. In the System Settings dialog box, click the Advanced tab, and then click 
the Settings button under Performance.

4. In the Performance Options dialog box, select the Advanced tab.

5. Under Virtual Memory, click Change, and then select the Custom Size 
button.

6. If you have more than one hard drive, select the hard drive you want the 
swap file to be located on. Preferably, this should be the hard drive with the 
fastest access time.

7. Under Paging file size for selected drive, specify 192 MB as the Initial Size 
and 384 MB or more as the Maximum Size.

8. Click Set, and then click OK.



Installing and activating RSView32   n  15

Uninstalling RSView32
To uninstall RSView32, use the Uninstall RSView32 program.

To uninstall RSView32
1. Click the Windows Start button, point to Settings, and click Control Panel.

2. Double-click Add/Remove Programs, select RSView32 7.60.00, and click 
Add/Remove.

3. Follow the on-screen instructions.

4. When the Uninstall program is complete, restart Windows.
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Chapter

2 Getting started

Welcome to RSView32
RSView32™ is Windows®-based software for developing and running human-
machine interface applications.

Designed for use in Microsoft® Windows Server 2003, Windows XP,  
Windows 2000 and Windows Vista environments, RSView32 gives you all the 
tools you need to create and run effective monitoring and supervisory control 
applications.

RSView32 Works contains both development and runtime software. Use this 
software to develop and run RSView32 applications.

RSView32 Runtime contains only runtime software. Use this software to run 
applications developed in RSView32 Works.

RSView32 Works
RSView32 Works contains editors for creating a complete human-machine 
interface application and contains software for running the applications you 
create. Use the editors to create applications that are as simple or as 
sophisticated as you need. When you have finished developing your 
application, switch to run mode or use RSView32 Runtime (which is included 
with RSView32 Works and uses less memory), and run your application.
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With RSView32, you can:

 use the RSView32 ActiveX® and OLE container capabilities to take 
advantage of advanced technology. For example, embed Visual Basic® or 
other ActiveX components in RSView32 graphic displays to extend the 
capabilities of RSView32.

 create and edit displays with tools native to the Microsoft programs you are 
using now. With sophisticated object-oriented graphics and animation, plus 
simple drag-and-drop and cut-and-paste techniques, application 
configuration is simplified.

 use the RSView32 Object Model and VBA to share data with other 
Windows programs such as Microsoft Access and Microsoft SQL Server, 
interoperate with other Windows programs such as Microsoft Excel, and 
customize and extend RSView32 to fit your unique needs

 use graphics from the RSView32 graphic libraries or import files from other 
drawing packages such as CorelDRAW®, and Adobe® Photoshop®

 develop your application quickly using RSView32 productivity tools such as 
the Project Documentor, Project Transport Wizard, Command Wizard, 
Tag Browser, and Object Smart Path™ (OSP)

Use the Graphic
Display editor to
create graphical
displays of your

process.
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 avoid entering information twice. Import an Allen-Bradley® PLC or SLC™ 
database with the PLC Database Browser. Or browse for tags in third-party 
OPC® servers. To import ControlLogix® tags, use the Logix 5000 Tag 
Import utility.

 use the RSView32 alarm notification capability to monitor process incidents 
with multiple levels of severity. Create multiple alarm summaries to provide 
specific alarm data rather than viewing the alarms for the entire system.

 create trends that show process variables plotted against time. Display real-
time or historical data with up to 16 pens (tags) in each trend.

 log data simultaneously to multiple log files or remote ODBC databases to 
provide various records of production data. Bring the logged data directly 
into other third-party programs such as Microsoft Excel and Crystal 
Reports® without converting files.

 lock users into the RSView32 application by disabling Windows keys

 use the electronic signature verification and authorization feature to verify 
the identity of the operator before an action can occur. This feature allows 
you to meet the security standards required for regulated manufacturing 
applications, for example those required for US Government 21 CFR 
Part 11 compliance.

RSView32 Runtime
RSView32 Runtime contains the software for running RSView32 applications. 
RSView32 Runtime also contains a sub-set of the RSView32 Works editors, so 
you can edit selected parts of a project at runtime. RSView32 Runtime is 
bundled with RSView32 Works or can be purchased separately.

With RSView32 Runtime, your application uses less memory to run.
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Quick Start steps
The following steps explain how to get up and running with RSView32. To 
work with RSView32, you must complete steps 1 and 2 in the specified order. 
The other steps can be completed in any order.

Step 1    Create a project
Create the project that you will run. A project is a folder on your hard disk that 
contains, among other things, the RSView32 project file (*.RSV).

For details, see Chapter 3, Creating and working with projects.

Step 2    Set up communications in RSView32
Establish communications between RSView32 and the hardware and devices 
you are using. 

For communications with most Allen-Bradley devices as well as SoftLogix™ 
5 devices, RSView32 uses a direct driver connection. RSView32 uses the 
drivers in RSLinx®.

To set up direct driver communications to devices, set up a channel and node 
and, optionally, a scan class.

For communications with other local and remote devices, RSView32 uses 
OPC or DDE connections. 

OPC (OLE for process control) allows RSView32 to act as a client or server, 
allowing peer-to-peer communication between different RSView32 stations, as 
well as other OPC servers. 

RSView32 uses standard or high-speed AdvanceDDE™ (dynamic data 
exchange) data formats to communicate with DDE servers and DDE clients 
such as Microsoft Excel.

To set up OPC or DDE communications, set up an OPC or DDE node.

For details, see Chapter 4, Setting up communications.

Step 3    Create graphic displays, trends, and 
alarm summaries
Create graphic displays that represent your process. Build your graphic displays 
in a variety of ways:
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 use the RSView32 drawing tools to create graphic objects and text. You can 
create simple objects such as ellipses and rectangles, or create more complex 
objects such as trends and alarm summaries. You can also embed ActiveX 
objects.

 drag and drop ready-made objects from the RSView32 libraries into a 
display

 import objects or entire images that have already been created in other 
drawing packages such as CorelDRAW

Create graphic displays, trends, and alarm summaries in the Graphic Display 
editor.

For details, see Chapter 5, Creating displays, trends, and alarm summaries.

Step 4    Set up tags
Create tags in any combination of ways:

 create tags as needed using the Tag Browser

 create a complete tag database in the Tag Database editor

 import an existing Allen-Bradley PLC or SLC database using the PLC 
Database Browser 

 import ControlLogix tags using the Logix 5000 Tag Import utility

 browse for tags in third-party OPC servers

For details, see Chapter 6, Creating tags.

Step 5    Set up logging
Set up activity, alarm, and data logging to have a permanent record of what is 
happening when your system is running.

Set up activity logging in the Activity Log Setup editor. Set up alarm logging in 
the Alarm Log Setup editor. Set up data logging in the Data Log Setup editor.

All logged information is stored in dBASE® IV (.DBF) format and can be 
viewed with third-party software such as Microsoft Excel, Crystal Reports, and 
Visual FoxPro®. For data logging, you can also use the ODBC storage format 
to store data directly in an ODBC-compliant database.

For details, see Chapter 7, Setting up logging and security.
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Step 6    Secure your system
Set up security at the:

 Project level so you control which users or groups of users have access to 
which features. 

In addition, at the project level, you can use the signature button to verify 
and track actions such as tag writes and running commands. This feature, 
together with other RSView32 security features, allows you to meet the 
security standards required for regulated manufacturing applications, for 
example those required for US Government 21 CFR Part 11 compliance.

 System level so you lock users into your RSView32 application. For 
Windows Vista, Windows Server 2003, Windows XP and Windows 2000, 
set up system-level security using the Win2K XP DeskLock tool, included 
on the RSView32 Resources CD-ROM. These tools are also available from 
the Windows Start menu, on the RSView32 Tools menu.

For details, see Chapter 7, Setting up logging and security.

Step 7    Customize and integrate RSView32 with 
other applications
Use the RSView32 Object Model with Visual Basic or Visual Basic for 
Applications (VBA) to customize and extend the capabilities of RSView32, and 
to integrate RSView32 with other applications. Some ways you might do this 
include:

 Networking. If your RSView32 application includes logic to switch between 
redundant PLCs, you can use the RSView32 Object Model with Visual 
Basic or VBA to include node information in a graphic display. This lets you 
indicate the station number of the active PLC, and allows an operator to 
take corrective action if a PLC goes offline.

 Tag management. Write a VBA program to modify alarm information, 
such as thresholds and severities, each time a different product is 
manufactured on a multipurpose production line.

 User and access control. Within a VBA program, check the security code 
for an engineer or operator, and then allow the VBA program to change 
alarm configurations, or display only status information, depending on the 
person’s level of access.
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 Alarms. Write your own alarm detection algorithms using Visual Basic or 
VBA, and then add alarm events to RSView32, to respond to your 
algorithms for annunciation, logging, printing, and for display in alarm 
summaries.

 Data logging. Use the RSView32 Object Model and other object models to 
collect data from multiple sources, such as expert systems, self-tuning PID 
algorithms, and tags, and then view the data in trends. You can also filter 
data for your own needs by reading from one data log model, and then 
writing to another data log model.

 Activity logging. Use the RSView32 Object Model with Visual Basic or 
VBA to log specific operator actions for tracking and documentation 
purposes. Write activity information to customized categories for sorting 
and analysis.

 Application interfacing. Use the RSView32 Object Model to interface with 
the object models of other applications. For example, you can use the 
Microsoft Excel object model to create a report in a worksheet, to add 
statistical formulas for analysis, and then print the report.
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Chapter

3 Creating and working 
with projects

Creating a project
To begin working in RSView32™, you need to create a project (also referred to 
as an application). For more information about projects, see “What is a 
project?” on page 26.

To create a project, click the New button on the toolbar or click New on the 
File menu.

After you create a new project, a Project Manager appears displaying the name 
of the project.

New

The project name,
including the path,

can be up to 200
characters long.

To specify a
different name for
the subdirectory,

type it here.
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What is a project?
A project consists of a folder on your hard disk that contains, at a minimum, 
the following items:

 project file (*.RSV)

 tag folder

 comprf (communications profile) folder

 cache folder

The *.RSV file contains general project information such as a list of project 
components and their directory locations and version numbers. By default, all 
project components are located locally in folders under the project folder, but 
they can also be located in other directories or shared with other projects 
running on other computers. 

Project files
The following table lists the default RSView32 folders.

Folder Contents File extensions

project name RSView32 project file, security 
and user account files, and the 
folders described below

.rsv, .sec, .act

project name\actlog Activity log files .dbf

project name\almlog Alarm log files .dbf

project name\als Alarm summary files .als

project name\cab ActiveX® control setup files .cab

project name\cache RSView32 internal files .ctl, .dat, .idx

project name\comprf Internal information on 
channels, nodes, and scan 
classes

.csv, .ctl
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project name\dlglog Data log models
Data log files
Information for current file set
Information for historical file 
sets

.mdf

.dbf

.dns

.dlg

project name\dts Derived tag files .dts

project name\eds Events files .eds

project name\gfx Graphic display files .gfx

project name\key Global key files .key

project name\mcr Macro files .mcr

project name\par Parameter files .par

project name\rcp Recipe files .rcp

project name\tag Tag database files
Tag cache file

.db, .ctl, .dat

.cac

project name\tgs Tag monitor files .tgs

project name\vba RSView32 VBA code files .vba

Folder Contents File extensions
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Exploring the RSView32 main window
Once you create a project in RSView32, you will see the RSView32 main 
window.

The menu bar
The menu bar contains the menu items for the active window. Each editor has 
its own set of menus.

The toolbar
The toolbar contains buttons for commonly used menu items so you can 
quickly access the items without opening the menu. When you point to a 
button on the toolbar, the button name is displayed in a tooltip.

Activity bar
Status bar

Toolbar

Menu bar

Project
Manager

Tooltip
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The Project Manager
The Project Manager contains the editors for creating and editing the 
components that will make up your project. For more information about the 
Project Manager, see “Working in the Project Manager” on page 31.

The activity bar
The activity bar shows system activities. To log activities to the activity bar, the 
Activity Bar check boxes must be selected in the Activity Log Setup editor. For 
details, see Chapter 8, Configuring Activity Logging, in the online RSView32 User’s 
Guide.

The status bar
The status bar provides different kinds of information depending on where the 
pointer is and what RSView32 is doing. It can provide information on:

 the active window or selected tool

For example, if you position the pointer over the Open button, the 
following message appears in the status bar:

 the location of a project component

For example, if you select a component in the Project Manager, the status 
bar shows the path to the component, such as:
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Showing and hiding the toolbar, status bar, and 
activity bar
You can display or hide the toolbar, status bar, and activity bar using the items 
on the View menu. If there is a checkmark beside the item, the bar is visible. If 
there is no checkmark, the bar is hidden.

Using the activity bar

You can detach the activity bar from the RSView32 main window and move 
the bar anywhere on the screen. However, you can attach the bar only to the 
bottom of the main window. To move the bar when it is not attached, grab the 
title bar and drag.

When the bar is not attached to the window, you can resize it. To show more 
messages, grab the bottom of the bar and drag to make it bigger.

To clear the most recent message in the activity bar, click Clear. To clear all the 
messages in the activity bar, click Clear All.

The toolbar and status bar are 
visible, but the activity bar is not.

To detach the activity bar, place the pointer
between the buttons, and drag the mouse.
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Working in the Project Manager
Each time you create a project, a Project Manager appears showing the project 
name.

The Project Manager window is divided into two panes. When you first create 
a project, the left pane appears with a series of folders and the right pane is 
empty. As you create project components, they are displayed in the right pane.

The parts of the Project Manager are described below.

Project name

Right pane

Tabs

Editor

Left pane

Folder
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Tabs
The Project Manager contains tabs so you can easily switch between edit and 
run modes. The Edit Mode tab contains the editors for developing your 
project. The Run Mode tab contains the components that you can use at 
runtime. Switching between the two tabs allows you to test your project quickly 
as you create it.

In run mode, you can run individual project components, or you can run the 
entire project. When you are in this mode, you see what users of your project 
will see. Double-click a component to run it.

For detailed information about running a project, see Chapter 18, Running your 
project, in the online RSView32 User’s Guide.

Folders
The Project Manager uses folders to organize editors. To open or close a folder, 
do one of the following:

 double-click the folder

 press Enter to either open or close the folder depending on its current state

 select the folder, right-click to open the context menu, and then click 
Expand or Collapse

Editors
Editors are for creating or configuring project components. To open an editor, 
do one of the following:

 double-click the editor’s icon

 select the editor’s icon, right-click to open the context menu, and then click 
New or Show

Right-click to view 
the context menu.

Right-click to view 
the context menu.
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The context menu contains New if you can create a component with the editor 
and contains Show if you cannot create a component with the editor.

The following table describes each editor.

Use this editor To

Channel Specify channels for direct driver communication with 
devices. Channels must be set up before you configure 
nodes for direct driver devices.

Node Assign names and define attributes for the direct driver 
devices, OPC® servers, or DDE servers that RSView32 
will communicate with.

Scan Class Set up the rate for scanning tags that communicate with 
direct driver devices.

Tag Database Create tags and set up alarms.

Tag Monitor Display the realtime values of a tag or group of tags.

User Accounts Assign security codes to users to limit access to a project.

Security Codes Assign security codes to commands and macros.

Activity Log Setup Specify the type of system activity you want to log and 
where, when, and how you want it logged.

Activity Log 
Viewer

View activity log files.

Startup Specify how your project will look and what will run when 
the project starts.

Command Line Open a command line for entering RSView32 commands.

Display Create graphic displays.

Library Drag and drop objects from the graphic libraries into your 
graphic displays.
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Parameters Create a parameter file for use with graphic displays 
containing tag placeholders, so you can use the same 
graphic displays with different tags.

Recipe Create a recipe file for use with graphic displays containing 
a recipe field.

Alarm Setup Configure where, when, and how you want alarm messages 
logged.

Alarm Log Viewer View historical alarm information.

Alarm Summary Specify the alarm information you want displayed and 
create a format for that information.

Suppressed List Display a list of tags for which alarm notification is 
suppressed.

Data Log Setup Create data log models, specifying where, when, and how 
you want selected tag values logged.

Derived Tags Create tags whose values are derived from other tags and 
functions.

Events Create events, which are expressions that trigger 
commands or macros.

Macro Create macros to run a series of RSView32 commands. 

Global Keys Remap your keyboard to run RSView32 commands.

Visual Basic® 
Editor

Create VBA code to do conditional branching, issue 
RSView32 commands, or link RSView32 data to other 
applications.

Use this editor To
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Components
Components appear in the right pane of the Project Manager. A component is 
a reference to a physical file. The component can reference a file in a folder 
under the project directory, a file outside of the project directory, or a file on 
another computer.

Displaying components

To display components, select an editor. Any components created with the 
editor appear in the right pane of the Project Manager. 

Opening components

To open a component, do one of the following:

 double-click the component

 select the component, and then click the Edit button in the Project Manager

 select the component, right-click to open the context menu, and then click 
Edit

These components 
were created with 
the Graphic Display 
editor. 

Right-click to view the 
context menu.
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For detailed information about using the Remove, Rename, and Delete menu 
items, see Chapter 1, Working with projects, in the online RSView32 User’s Guide.

Viewing component locations

Components can reference files in different locations. To view the location of 
the component’s file, select the component in the Project Manager, and then 
check the location displayed in the status bar.

The component Cooling Area is located at:

The component Oven Area is located at: 

Using the same component in more than one project

The same files can be used in more than one project by adding components to 
a project using one of two options. When you add a component in the Project 
Manager using the Copy Existing Component into Project option, you are 
creating a copy of the file in the project. When you add a component using the 
second option, Create Shortcut to Existing Component, you are not creating a 
copy of the file in the project. Instead, you are creating a path to the file’s 
location outside of the project. The advantage of this method is that there is 
only one copy of the file, and changes made to it are available to all projects 
using the file.

To add a component, select the editor that was used to create the desired 
component, right-click to display the context menu, and then click Copy 
Existing Component into Project or click Create Shortcut to Existing 
Component.

In the dialog box, locate the component you want to add and click Open. The 
component appears in the right pane of the Project Manager. Files that are 
located outside of the project have an arrow symbol on the component icon, 
as shown on the previous page for the Oven Area component.
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Hints for working in editors
When developing a project, you will use many different editors, but they have 
many similar features and often require similar information. Knowing how to 
use these features saves time.

Using the context menus
The Project Manager and the Graphic Display editor use context menus. To 
open a context menu, right-click the mouse. 

Using the Selection button
The Selection button appears beside data-entry fields. You can type 
information into the fields, or you can click the Selection button to open a list 
containing valid entries for the field.

Entering tag names
Many editors require a tag name. Tags are stored in the tag database and their 
names are then used in other parts of RSView32. You do not have to create tags 
before you work in other editors.

To supply a tag name, use any of these methods

 type the name of a tag that already exists in the tag database

 click the ... (Selection) button or Tags button, whichever is available, to 
open the Tag Browser where you can select, create, or edit a tag

 type the name of a tag that is not yet created. When you try to save, you are 
prompted to create the tag. You do not have to create the tag to use the tag 
name, but be sure to create the tag later or errors will be reported at runtime.

For detailed information about tags, see Chapter 4, Creating tags, in the online 
RSView32 User’s Guide.

Selection button
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Using RSView32 commands
Many editors require an RSView32 command. Commands allow you to control 
RSView32 at runtime. Most commands accept parameters for added precision 
and control. You can also create a list of RSView32 commands in a macro and 
use the macro name in places where commands are required.

Using the Command Wizard

The Command Wizard helps you select and build commands.

To open the Wizard, do one of the following:

 click the ... (Selection) button beside any action field or in the command line

 double-click in an action field or, in the Macro editor, in any area of the 
window

 click the Commands item on the Edit menu

For detailed information about RSView32 commands, see Appendix A, 
RSView32 Commands, in the online RSView32 User’s Guide, or see online help.

Using expressions
Many editors use expressions to compute values based on tags and functions. 
Expressions can be complex logical expressions, or they can be tag names.

For detailed information about expressions, see Chapter 14, Creating expressions, 
in the online RSView32 User’s Guide.

Click a folder to
display the

commands in a
category.

When you click a 
command the 
command 
syntax is 
displayed here.
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Using the Project Documentor
The Project Documentor is a utility that provides you with detailed information 
on RSView32 projects. This utility is a browser that allows you to view the 
contents of the project’s components and the tags used in these components. 
You can also print and export the information.

For more information, see the Project Documentor Help, included on the 
RSView32 Resources CD-ROM, and also available from the RSView32 Tools 
menu on the Windows Start menu.

Using the Project Transport Wizard
The Project Transport wizard lets you:

 rename a project

 copy a project

 delete a project

 back a project up to a .zip file

 restore a project that has been backed up to a .zip file.

For more information, see the Transport Help, included on the RSView32 
Resources CD-ROM, and also available from the RSView32 Tools menu on 
the Windows Start menu.

Using components from ControlView projects
Many components, such as graphic displays or tag databases, can be imported 
from a ControlView™ or ControlView Builder project into RSView32. For 
more information, see the ControlView Project Import Wizard Help, included 
on the RSView32 Resources CD-ROM, and also available from the RSView32 
Tools menu on the Windows Start menu.

For a description of how RSView32 differs from ControlView and 
ControlView Builder, see Appendix C, Differences Between RSView32 and 
ControlView, in the online RSView32 User’s Guide.
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4 Setting up 
communications

Using direct driver communications
For communications with most Allen-Bradley® devices, RSView32™ uses a 
direct-driver connection. RSView32 uses the drivers in RSLinx® to 
communicate with Allen-Bradley devices.

To communicate with SoftLogix™ 5 programmable controllers, you must use 
an RSLinx driver.

You must use the version of RSLinx that came with your RSView32 software. 
This version has been tested for compatibility with RSView32. Other versions 
may not function correctly.

If you are not using Allen-Bradley devices—for example, if you are using 
Siemens or Modicon devices—use OPC® or DDE communications. For 
details, see “Using OPC and DDE communications” on page 43.

Windows Service Packs
If your operating system is Windows Server 2003, use Service Pack 1 or later.

If your operating system is Windows XP Professional Edition, use Service 
Pack 1 or later.

If your operating system is Windows® 2000 Professional or Windows 2000 
Server, use Service Pack 4.

If your operating system is Windows Vista Business (32-Bit) or Windows Vista 
Home Basic (32-Bit), use Service Pack 1 or later.
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Communications editors
To set up direct-driver communications, open the System folder in the Project 
Manager, and use the editors shown below.

Setting up direct driver communications
1. Start RSLinx and then configure and load the appropriate communications 

driver.

2. Start RSView32 and create or open a project.

3. In the Channel editor, select a channel and assign the appropriate network 
and the RSLinx driver to it.

4. In the Node editor, create nodes for each programmable controller you 
wish to communicate with. In the Data Source field, select Direct Driver.

5. If you want to change the default rate at which nodes are scanned, edit the 
scan classes in the Scan Class editor. This step is optional.

6. In the Tag Database editor, create tags. In the Data Source Type field, 
choose Device. In the Node Name field, choose one of the nodes you have 
created. In the Scan Class field, choose a scan class. In the Address field, 
specify the physical memory location in the programmable controller.

7. Check that communications are working. For details, see “Checking that 
communications are working” on page 44.

Use these editors
to set up

communications.
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Using OPC and DDE communications
For communications with a wide range of local and remote devices, RSView32 
uses OPC or DDE connections. OPC (OLE for process control) allows 
RSView32 to act as a client or server, allowing peer-to-peer communication 
between different RSView32 stations, as well as other OPC servers such as 
KEPServerEnterprise™. RSView32 can browse tags in other OPC servers, and 
also provides for OPC tag browsing of RSView32 tags. RSView32 supports 
OPC 1.0 and OPC 2.0.

RSView32 uses standard or high-speed AdvanceDDE™ (dynamic data 
exchange) data formats to communicate with DDE servers and DDE clients 
such as Microsoft Excel.

If you are not using Allen-Bradley devices—for example, if you are using 
Siemens or Modicon devices—you can use OPC or DDE to communicate 
with the devices. 

Communications editors
To set up OPC or DDE communications, open the System folder in the 
Project Manager, and use the editors shown below.

Use these editors
to set up

communications.
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Setting up communications with OPC and DDE 
servers
1. Start the OPC or DDE server.

2. Start RSView32 and create or open a project.

3. In the Node editor, create nodes for each OPC or DDE server and/or 
topic you wish to communicate with. In the node’s Data Source field, 
select OPC Server or DDE Server, according to which type you are using.

4. In the Tag Database editor, create tags. In the Data Source Type field, 
choose Device. In the Node Name field, choose the OPC or DDE nodes 
that you have created. In the Address field, specify the name of the tag in 
the OPC server, or specify the DDE item.

5. Check that communications are working. For details, see “Checking that 
communications are working” next.

Checking that communications are working
The simplest way to check if communications are working is to use the tag 
monitor. The tag monitor shows tag values and states. If you have not created 
a tag, use the Tag Browser in the tag monitor to create the tag.

Follow the steps below to check communications for direct driver, OPC, and 
DDE devices.

When
communications
are working, the

Value column
contains a value

and the State
column says Valid.
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To check communications for an existing tag

1. In the RSView32 Project Manager, open the System folder, double-click 
Command Line, and then enter ComStatusOn to start logging 
communication errors.

2. In the RSView32 Project Manager, open the System folder, and then open 
the Tag Monitor.

3. In the Tag Name column, type the name of a tag that you have created, and 
then press Enter.

If communications are working, a value will appear in the Value column and 
Valid will appear in the State column. If communications are not working, 
an error will appear in the State column, and an error message will appear 
in the activity bar.

To check communications for a new tag

1. In the RSView32 Project Manager, open the System folder, and then open 
the Tag Monitor.

2. On the View menu, click Form. 

3. Click the ... (Selection) button beside the Tag Name field to open the Tag 
Browser, and then click New Tag. 

4. Type a tag name, and then choose a tag type. Under Data Source Type, 
click Device. For Node Name, click the ... (Selection) button to display a 
list of the nodes you’ve created, and then select a node. In the Address 
field, type a programmable controller address for direct-driver 
communications, the name of a tag in the OPC server, or a DDE item. 
Click OK.

5. The newly created tag is selected in the Tag Browser. Click OK.

If communications are working, a value will appear in the Value column and 
Valid will appear in the State column.
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If communications are not working
 Check that the communication driver is properly configured.

To verify that the device you are trying to communicate with has been 
detected, in RSLinx use RSWho.

If the device appears in RSWho but a tag value is not displayed in 
RSView32, close your project, close RSView32, and then close RSLinx. 
Restart RSView32, reopen the project, and then open the tag monitor again. 
(RSLinx starts automatically when you restart RSView32.)

 For details about the type of communication errors you are experiencing, 
type ComStatusOn at the command line, then view the activity log in the 
Activity Log Viewer. To log communication errors, the Communications 
category must be selected in the Activity Log Setup editor. For details, see 
Chapter 8, Configuring activity logging, in the online RSView32 User’s Guide.
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5 Creating displays, trends, 
and alarm summaries

Creating and editing graphic displays
You can create any number of graphic displays as part of an RSView32™ 
project. A graphic display represents the operator’s view of plant activity. It can 
show system or process data and provide operators with a way to write values 
to an external device such as a programmable controller or server.

A graphic display is made up of graphic objects. To add objects to a display, 
you can:

 create objects using the editor’s drawing tools

 drag and drop objects from another display or a graphic library

 copy and paste objects from another Windows® application

 import objects or entire displays created in other drawing packages such as 
CorelDRAW®, and Photoshop®
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 embed ActiveX® and OLE objects.

Some objects have animation attached to them so they change appearance to 
reflect changes in plant activity. To attach animation, you must specify one or 
more tags that will control the object’s appearance and specify how the 
appearance will change as the tag’s values change

Creating a new graphic display
To create a new graphic display, double-click the Graphic Display editor icon 
in the Project Manager.

Buttons for opening other displays

Trend display
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When the editor opens, you are presented with a new, blank display ready for 
you to begin work. The editor is your drawing space in which you can create 
any type of display you like. 

Saving and naming the graphic display

To save the graphic display, click the Save button. In the Save As dialog box, 
type a name for the display. The name can be up to 200 characters long 
(including the path) and can include spaces.

Types of displays
You can create any type of display in the Graphic Display editor. For example, 
you can create a full-screen display that serves as a main menu for all the other 
displays, or you can create a small display that pops up when required. What 
makes displays appear different to users is the display’s type, size, and behavior.

To see what
actions you can

perform, right-
click to open the

context menu.

Drawing area.

Move these
toolbars

anywhere you
want. To see

more toolbars,
use the View

menu.

When you test run a graphic display, the activity bar provides runtime information. To hide the 
activity bar, click the Project Manager, open the View menu, and then click Activity Bar. 
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The type of display you choose determines how the display interacts with other 
displays on the screen:

 Replace is the default display type. Use this option if you want the graphic 
display to replace other open graphic displays when it opens. RSView32 will 
close any graphic display that the newly opened display overlaps. This way 
you don’t need to issue separate commands to close the other displays.

 On Top is used to keep the graphic display on top at all times. It will remain 
on top even if another display has focus. However, if more than one graphic 
display of the On Top type is open at once, the display that has focus, or 
had the most recent focus, appears on top.

 Overlay is used if the graphic display doesn’t need to replace others or 
appear on top. The display will layer with other displays, overlapping some 
and being overlapped by others as the focus changes between multiple 
displays. Overlay displays always appear behind On Top displays, and are 
replaced by Replace displays. Use Overlay with care, because keeping 
multiple displays open can affect system performance.

You specify the display type in the Display Settings dialog box in the Graphic 
Display editor. Choose Display Settings on the context menu (shown on 
page 49) to open the dialog box.
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Opening and closing displays

RSView32 uses commands to open and close displays. To open a display, use 
the Display <file> command. To close a display, you can use the Replace 
display type (so that opening a new display causes other open displays to close), 
or use the Abort <file> command to explicitly close a display.

In the above example, the display type for the Bread - Main Menu display is 
Replace, so that the Norm’s Bakery - Main Menu display closes automatically 
(is replaced) when the Bread - Main Menu display opens. The following 
command has been assigned to the Breads button:

Display Bread - Main Menu

When a user clicks the Breads button, the Bread - Main Menu display opens 
and the Norm’s Bakery - Main Menu display closes. 

If the Bread - Main Menu display uses the Overlay or On Top display type, and 
you want the Norm’s Bakery - Main Menu display to close when the user opens 
the Bread - Main Menu display, assign two commands to the Breads button:

Abort Norm’s Bakery - Main Menu

Display Bread - Main Menu

Clicking the Breads
button opens the

Bread - Main Menu
display and closes

the Norm’s Bakery -
Main Menu display.
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Choosing a background color and display size
You can change a display’s background color and size any time during the 
drawing process. You can also set your own defaults so the Graphic Display 
editor opens just the way you want. Setting a default is one way to give your 
graphic displays a consistent look and feel.

Specify the background color and display size in the Display Settings dialog 
box. Right-click an empty area of the display and then click Display Settings on 
the context menu.

Choosing a display size

For most displays, use the Size to Main Window at Runtime option. Any 
display that uses this option is automatically scaled to occupy all of the 
RSView32 main window. You only need to specify the window size for smaller 
displays, such as pop-up or tiled displays.

Specify the 
background color.

You’ll probably 
want to specify Size 
to Main Window at 
Runtime for most 
displays.

To make your 
choices the default 
for all new displays, 
click Set as Default.
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Importing a graphic
You might like to include graphics you’ve already created in other applications. 
RSView32 imports many different graphic file types, including .BMP, .WMF, 
.DXF, and .JPG, so you can import images such as logos, photographs, or 
drawings of a machine or process.

You can import .DXF files generated by AutoCAD® version 12 or earlier 
directly. You must export .DXF files generated by AutoCAD version 13 or later 
to .WMF format and then import the .WMF files into RSView32.

To import a file, click the File menu and then click Open. Select the type of file 
to import in the Files of type field, locate the file you want to import, and then 
click Open.

The Norm’s Bakery
logo was imported

into the graphic
display.
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Viewing the libraries and samples
Before you start drawing objects, look at the graphic libraries and samples 
included with RSView32. The libraries and samples contain hundreds of 
objects that you can drag and drop into your display, saving you drawing time. 
Some of the objects might not be exactly what you need, but you can change 
them in any way you want—resize them, reshape them, change their color, and 
so on.

To see a list of the libraries, click the Library icon in the left pane of the Project 
Manager. The library components are listed in the right pane of the Project 
Manager.

Many library objects already have animation configured for them. When you 
drag and drop an object into a display, all animation attached to the object is 
retained. You can use the animation as is, but you will usually want to change 
the tag name associated with the animation. To change the tag name, use tag 
substitution.

Using tag substitution

With tag substitution, you can replace some or all of the tag, expression, or 
command references in a graphic display. Select an object or group of objects, 
right-click to open the context menu, and then click Tag Substitution.

Instead of drawing a slider, drag and drop it from the Sliders library.
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Creating a button
Use the Button tool to create, label, and specify an action for a button. You can 
create four different styles of button, and can attach any RSView32 command 
to the button to create the button’s action.

The button’s appearance is up to you. The fonts, colors, and fill styles available 
for other graphic objects are also available for button objects. You can also 
import a graphic image for the button so you can label the button with a symbol 
or picture. 

To create buttons that are the same size, create one button, and then duplicate 
it. To edit the duplicated button, double-click it to open the Button 
Configuration dialog box.

Button tool

The grid is helpful
when drawing

objects. To use the
grid, right-click an
empty area of the
display, and then

click Grid Settings.
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Adding an action to the button

Users expect buttons to perform actions, and the most common button actions 
are opening and closing displays.

To specify an action for a button, double-click it. In the Button Configuration 
dialog box, click the Action tab and then specify a command. For a complete 
list of RSView32 commands and their actions, use the Command Wizard, or 
see the online help.

In the example below, a display called Bread - Main Menu has been created and 
is used with the Display command. At runtime, when a user clicks the Breads 
button, the Bread - Main Menu display opens.

Click this button to 
open the Command 
Wizard and create a 
command.
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Embedding an ActiveX object
ActiveX objects are supplied independently of RSView32 through products 
such as Microsoft® Visual Basic® (version 4.0 or later). When an ActiveX object 
is embedded in a display, RSView32 can use the object’s features by linking the 
object’s properties to RSView32 tags and by linking the object’s events and 
methods to RSView32 commands.

The Baking display requires a gauge for monitoring oven temperature. Instead 
of drawing the gauge, the designer uses the Rockwell Software gauge object and 
attaches an RSView32 tag to the gauge’s Value property. At runtime, the 
gauge’s needle changes position to reflect the tag’s value.

To embed an ActiveX object, use the ActiveX tool. Drag the mouse to draw a 
box about the size you want for the object and release the mouse. In the Insert 
an ActiveX Control dialog box, double-click an ActiveX object. To link the 
object to an RSView32 tag, use the ActiveX Property Panel dialog box. Select 
the object, right-click to open the context menu, point to ActiveX, and then 
click Property Panel.

ActiveX tool
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You can view an object’s properties, methods, and events in two ways:

 to view the object’s properties, select the object, and then click ActiveX 
Property Panel on the View menu

 to view the properties, methods, and events through RSView32, select the 
object, right-click to display the context menu, point to Animation, point to 
ActiveX Control, and then click Properties, Events, or Methods

If you frequently use ActiveX objects in your displays you might want to add 
the icons for the objects you use to the ActiveX Toolbox. For more 
information, see Chapter 11, Creating graphic displays, in the online RSView32 
User’s Guide.

Select the property you want to link to a tag, and then type, or browse for the RSView32 tag name.
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Adding color to objects
You can change the color of objects before or after you draw them. Objects 
can have two colors—line color and fill color. Line color applies to the outline 
of an object, and to text. Fill color applies to the inside of an object.

To show the color palettes, click them on the View menu. Like toolbars, the 
color palettes can be placed anywhere on the screen and can be attached to any 
edge of the window. To apply color to an object, select the object and then click 
a new color on the appropriate color palette.

When you select an object, the object’s fill color is selected 
in the Fill Color palette. 
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Arranging the objects
Once you’ve created two or more objects, you can arrange them. You can align 
them, space them, and group them. To select multiple objects, click one object 
and Ctrl-click other objects. You can also select multiple objects by holding the 
mouse down and dragging. As you drag, a selection box appears around the 
objects; release the mouse when the box includes all the objects you want.

Aligning objects

Objects are aligned based on their relative positions. In the example above, 
clicking Align Top aligns the top of the Reports button to the top of the Breads 
button. Clicking Align Bottom aligns the bottom of the Breads button to the 
bottom of the Reports button.

Spacing objects

Spacing objects ensures there is an equal amount of space between each object. 
Objects are spaced based on the distance between the outside edges of the two 
outer-most objects. Use the buttons on the toolbar to space objects vertically 
and horizontally.

To show the Alignment 
toolbar, click Alignment 
Toolbar on the View menu. 
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Grouping objects

Grouping objects makes individual objects into a single object. Once objects 
are grouped, you can still work with the individual objects using group editing.

 

Animating objects
Most graphic objects can have animation attached to them. Groups of objects 
can also have animation. You can attach as many types of animation as you like. 
For example, apply both width and height animation to an object so it looks 
like it is moving out of or into the display as it grows and shrinks.

Using Object Smart Path

Attaching animation to objects is easy with Object Smart Path™ (OSP). With 
OSP, you define an object’s range of motion by dragging the object—there’s 
no pixel counting involved.

Click to select 
the group.

Double-click to 
edit the group.

Click an object to 
select and edit it.
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OSP works through the Animation dialog box. The Animation dialog box can 
stay open all the time, so you can move between it and the graphic display. To 
open the Animation dialog box, select an object, right-click to display the 
context menu, click Animation, and then click a type of animation.

To set up the object’s start position, place the object where you want it to start, 
and then click At Minimum in the Animation dialog box. To set up the object’s 
end position, drag the object to where you want it to end, and then click At 
Maximum in the Animation dialog box.

Copying and pasting animation

You can copy the animation from one object and paste it on another object. If 
the object has more than one type of animation, all animation is copied and 
pasted. To copy animation, select the object with the desired animation, right-
click to open the context menu, and click Copy Animation. To paste animation, 
select the object you want to paste animation to, right-click to open the context 
menu, and then click Paste Animation.

The slider is shown
in its At Minimum

position.
Whenever the tag

associated with the
slider is at its
minimum, the

slider is in this
position.
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Testing the animation
To test the animation in a display, use test mode. In test mode, RSView32 
collects data from the data source and animates your display. However, test 
mode does not change the size or position of your display. When you’re 
finished testing, return to normal mode to continue editing. To switch between 
normal and test mode, click the buttons on the toolbar or click the options on 
the View menu.

Setting up runtime appearance
You can specify how each graphic display will appear at runtime. You can 
specify the display type, window style, and window size and position. The 
window style includes whether the window will have a title bar and, if so, what 
the title bar will say and what buttons it will include.

Test Mode

Normal Mode

 If you don’t
include a title bar,
you cannot have

items such as the
Minimize button

that are part of the
title bar.
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Creating a trend
A trend is a visual representation of realtime or historical tag values, which 
provides operators with a way to track plant activity as it is happening.

With RSView32 trends, you can:

 plot data for up to sixteen tags in each trend object

 plot constant values as well as tag values

 use shading to emphasize when a tag crosses a reference value

 use realtime data from tags or use historical data from log files

 use data from a local or remote computer

You can drag and drop a trend from a graphic library into your display, or you 
can create a trend with the Trend drawing tool.

To use a trend from the graphic libraries, click the Library icon in the left pane 
of the Project Manager, and then double-click Trends in the right pane of the 
Project Manager. Select all or part of the trend and drag and drop it into your 
display. Use tag substitution to update the tags associated with the trend. For 
details, see “Using tag substitution” on page 54.

Each line, or
pen, represents

a tag value.

Each pen’s tag
name appears
in the legend.

The numbers 
along this axis 
represent the 
minimum and 
maximum 
values for the 
tag selected in 
the legend.

The sliders and buttons around the trend are graphic objects created separately from the 
trend but are important because they control the trend at runtime. You can find these 
objects in the Trends library.
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To create a trend, click the Trend tool. Drag the mouse to draw a box about 
the size you want for the trend and then release the mouse. In the Trend dialog 
box, set up the trend.

For detailed information about trends, see Chapter 13, Configuring trends, in the 
online RSView32 User’s Guide.

Creating an alarm summary
An alarm summary displays the alarm information recorded in the computer’s 
memory. The summary is completely configurable, so you can determine what 
and how alarm information is displayed.

The summary can list up to 1,000 alarm entries. As new alarms occur, they 
appear at the top of the list. When the summary becomes full, one alarm is 
removed from the bottom of the list for each new alarm that appears at the top. 
Alarms are also removed when they are out-of-alarm and acknowledged.

Trend tool

Although you can
add many

headings, too
much information

can be
overwhelming.

The button bar can contain a variety of buttons and can be placed on any edge of the alarm summary. 
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Filter alarms
To limit the information included in an alarm summary, filter out the 
information you don’t want. You can filter information by tag name, tag type, 
alarm severity, and alarm state.

Assign colors to alarms
You can configure alarm incidents to be a different color. For example, you 
might configure alarms of low severity as blue, medium severity as yellow, and 
high severity as red. When the alarm is displayed, the operator can tell an 
alarm’s severity at a glance. You can also configure different blink styles for 
different alarm severities, as well as for Out of Alarm and Fault State messages.

You can drag and drop an alarm summary from a graphic library into your 
display or you can create an alarm summary with the Alarm Summary tool.

To use an alarm summary from the graphic libraries, click the Library icon in 
the left pane of the Project Manager. The libraries are listed in the right pane of 
the Project Manager. Double-click the Alarm Information library to open it. 
Select the alarm summary and drag and drop it into your display.

To create an alarm summary, click the Alarm Summary tool. Drag the mouse 
to draw a box the size you want for the alarm summary and then release the 
mouse. You will be presented with a blank alarm summary. To add headings, 
click the Insert menu. To add buttons, click Buttons on the Format menu.

Alarm 
Summary tool
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6 Creating tags

What is a tag?
A tag is a logical name for a variable in a device or in local memory (RAM). Tags 
that receive their data from an external source such as a programmable 
controller or server are referred to as device tags. Tags that receive their data 
internally from RSView32™ are referred to as memory tags.

Tags are stored in the tag database and their names are then used in other parts 
of RSView32. You can create tags in a combination of ways. You can:

 create tags as needed

 create many tags at once

 import tags from an Allen-Bradley® PLC database or from ControlLogix®

 create tags using the RSView32 Object Model and Visual Basic® or Visual 
Basic for Applications. For more information about using the RSView32 
Object Model, see Chapter 8, Using the RSView32 Object Model and VBA. 
Also see Help.

RSView32 provides for OPC® 2.0 browsing of RSView32 tags.

Tag types
RSView32 uses the following tag types:

 Analog tags store a range of values.

 Digital tags store 0 or 1.

 String tags store ASCII strings, a series of characters, or whole words. The 
maximum string length is 255 characters.
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 System tags store information generated while the system is running, 
including alarm information and the system time and date. RSView32 
creates system tags when a project is created and stores the tags in the 
system folder in the tag database. You cannot edit or write to system tags, 
but you can use them anywhere you would use any other tag.

Creating tags as needed
You can create tags as you need them while working in other editors. To create 
a tag, do one of the following:

 in any field requiring a tag or an expression, type a tag name. If the tag 
doesn’t exist in the tag database, you will be prompted to create the tag 
when you try to save. You can use the tag name without creating the tag, but 
be sure to create the tag later or errors will occur at runtime.

 click the Tags or ... (Selection) button, whichever is available, to open the 
Tag Browser. Use the Tag Browser to select, create, and edit tags.

Organize tags 
into folders. For details, see 
“Using folders to organize 
tags” on page 71.

Click this button to open the 
Tag Browser.
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Creating many tags at once
To create many tags at once, use the Tag Database editor. You can organize 
tags into groups using folders. Using folders speeds up database creation 
because you can duplicate a folder and its tags in a single operation. For 
example, if you have several similar machines that require the same tags, you 
can create a folder called Machine1 and define its tags. To create the tags for 
Machine2, duplicate the folder and change the node name or address of each 
tag in the new folder. 

You can also import tags created in other applications. To import tags, use the 
Database Import and Export Wizard. The Database Import and Export 
Wizard is available from the RSView32 Tools menu (on the Start menu, select 
Programs, Rockwell Software, RSView32 Tools, Database Import and Export 
Wizard).

For more information about using the wizard, see Database Import and Export 
Help.

Organize tags into folders. For details, see “Using folders to organize tags” on page 71. 
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Importing tags from an Allen-Bradley PLC database
You can selectively import tags from an Allen-Bradley PLC database into the 
RSView32 tag database. Tags imported in this way are copied into the 
database—they are not shared with the source database. This means changes 
to tags in RSView32 do not affect the database from which they’ve been 
imported and vice-versa.

To open the PLC Database Browser, click the Other DB button in the Tag 
Browser, or click the DB Browser button on the toolbar in the Tag Database 
editor.

Importing ControlLogix tags
To import ControlLogix tags, use the Logix 5000 Tag Import utility. The Logix 
5000 Tag Import utility is located on the RSView32 Tools menu (on the Start 
menu, select Programs, Rockwell Software, RSView32 Tools, Logix 5000 Tag  
Import).

For information about using the utility, see the Logix 5000 Tag Import Help.

Button in Tag 
Database editor

Button in Tag 
Browser

To locate your 
database, click 
Browse.Filter and

search for the
tags you want to

import.

To specify or 
create a folder 
for the tags, 
type the folder 
name here.
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Using folders to organize tags
To organize tags, create a folder and include tags that are related to one another. 
To separate the folder name from the rest of the tag name, use a backlash (\). 
For example, tags in the folder called Breads would start with Breads\. For 
greater organization, you can nest folders; for example, Breads\Baking\Oven.

For more information about organizing your tag database, see “Designing a 
database” on page 98.
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7 Setting up logging and 
security

Logging information
You can log:

 Activities. The activity log records information about various types of 
system activity, including command or macro usage, tag writes, system 
messages and errors, and communication errors. If you use the electronic 
signature button, the activity log records the name and comment of the 
operator who initiates the button’s action, and, if required, the name and 
comment of the supervisor who authorizes the action. 

To set up activity logging, use the Activity Log Setup editor. To set up the 
electronic signature button, use the Graphic Display editor.

 Alarms. The alarm log records alarm incidents, including when a tag goes 
into alarm, when a tag goes out of alarm, and when an alarm is 
acknowledged. The name of the user who acknowledged the alarm is also 
logged. To set up alarm logging, use the Alarm Log Setup editor.

 Data (tag values). The data log records specific tag values, or data, under 
certain conditions. These conditions are defined by a data log model. To set 
up data logging, use the Data Log Setup editor.

Setting up logging
Activity logging, alarm logging, and data logging use similar editors to set up 
logging. For each type of logging, specify where to store log files, when to 
create and delete log files, and what particular information to log. The 
illustration below shows the Data Log Setup editor.
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For each type of logging, you can create up to 26 log files per day. As files are 
created, they are automatically named based on the date the file was created and 
the type of data it contains. For data logging only, if you choose to use long file 
names you can create up to 9,999 log files per day.

Viewing logged information
There are several ways to view logged information:

 Activities. View activity information in the Activity Bar and the Activity 
Log Viewer.

 Alarms. View alarm information in the Alarm Log Viewer and in alarm 
summaries.

 Data (tag values). View tag data in realtime and historical trends. Realtime 
trends show data as it is being collected. Historical trends show data from a 
log file or ODBC database.

All logged information is stored in dBASE® IV (.DBF) format, which can easily 
be displayed or analyzed in third-party software such as Microsoft® Excel, 
Crystal Reports®, and Visual FoxPro® without file conversions or importing 
and exporting.

Set up general
aspects of the model.

Specify when to
create and delete log

data.

Specify when to log
tag values.

Specify which tags
to log.

With data logging, you 
also specify which 
storage format you 
want—narrow dBASE 
IV, wide dBASE IV, or 
ODBC. This is not an 
option with the other 
types of logging.

Specify where to log
the data to.



Setting up logging and security   n  75

For data log only, you also have the option of storing data using the ODBC 
storage format, and viewing the data in an ODBC-compliant relational 
database application.

For activity and alarm logging, you have the option of exporting data to an 
ODBC-compliant database, and viewing the data in an ODBC-compliant 
relational database application.

Securing your system
You can set up security at the project level and the system level.

Project-level security controls which users or groups of users have access to 
certain features in your project. For example, you might not want all users to 
be able to change tag values, so you would restrict access to tags. You can also 
restrict access to graphic displays and RSView32 commands.

You can also use the signature button to verify and track actions such as tag 
writes and running commands. This feature, together with other RSView32™ 
security features, allows you to meet the security standards required for 
regulated manufacturing applications, for example those required for US 
Government 21 CFR Part 11 compliance. 

System-level security locks users into your RSView32 project so they cannot 
exit to Windows®.

Setting up project-level security
Setting up security codes and user accounts

The first step in setting up security is assigning security codes. You can limit 
access to any RSView32 command, graphic display, or tag by assigning a 
security code to it. There are 17 codes—an asterisk (*) and the letters A through 
P. The asterisk allows unlimited access, and the letters limit access. 

Assign security codes in the following places:

Assign a security code to In the

An RSView32 command Security Codes editor

A graphic display Display Settings dialog box in the 
Graphic Display editor
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Once you have assigned the security codes, you can then assign the codes to 
users or groups of users. In this way, you can limit users’ ability to run 
commands, open displays, and write to tags. Use the User Accounts editor to 
assign security codes to users.

When adding users to RSView32, you can enter user names and passwords in 
the User Accounts editor, or, if you are using Windows Vista, Windows Server 
2003, Windows XP or Windows 2000, you can use the Windows user list 
instead of creating a custom list in RSView32. No matter which method you 
use, you still have to assign security access to the individual users.

Security is active whenever a project is loaded. If no user is logged into the 
project, the default user (from the User Accounts editor) is active.

A tag Tag Database editor

Assign a security code to In the
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In the above example, the Default user has access only to security code “A”. 
That way, when no user is logged in, there is no access to any part of the project 
other than the Login and Logout commands. The manager has access to all 
security codes, so is able to access all parts of the project. The operators have 
access only to security codes “A” and “C”.

. . . and then assign codes to users.

Assign security codes to commands . . .
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Setting up electronic signature buttons

In addition to limiting access on a tag-by-tag or command-by-command basis, 
you can use the electronic signature button to keep track of who initiates 
actions such as tag writes and running commands. You can also require that the 
action is approved by a pre-authorized verifier before the action is initiated.  

You can use the electronic signature button to secure these operations:

 setting a tag value

 issuing an RSView32 command

Add the electronic signature button to your graphic displays in the Graphic 
Display editor.

At runtime, the operator must enter a name, password, and comment before 
the action assigned to the button is initiated. Optionally, you can also require 
that a supervisor approve the action by entering a name, password, and 
comment. The names and comments are recorded in the activity log, allowing 
you to keep a permanent record of who initiated the actions and why.

When the operator clicks this 
button, the RSView Electronic 
Signature dialog box opens, 
and the user must be 
authenticated before the new 
tag value is downloaded to the 
programmable controller.
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Setting up system-level security
System-level security locks users into your RSView32 project so they can’t exit 
to the Windows operating system or switch to other Windows programs. To 
set up system-level security, set up your displays as described below and use the 
additional security appropriate for your operating system.

Setting up displays

No matter which operating system you’re using, you can help prevent users 
from going outside of the RSView32 project by setting up your displays as 
follows:

 do not include title bars or minimize and maximize buttons on graphic 
displays by clearing the appropriate check boxes in the Display Settings 
dialog box in the Graphic Display editor

 ensure RSView32 occupies the entire screen by maximizing RSView32 and 
removing the Windows taskbar. 

To maximize RSView32, place a shortcut to RSView32 in the Windows 
startup folder, and set the shortcut’s run setting to Maximized. For details 
about creating shortcuts, see your Windows documentation. 

To remove the taskbar in Windows Vista, Windows Server 2003, 
Windows XP and Windows 2000, clear the Always on top check box and 
select the Auto hide check box in the Taskbar Properties dialog box.
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Disabling Windows shortcut keys

To disable the shortcut keys, use the Startup editor.

Replacing the desktop in Windows Vista, Windows XP, Windows 
2000 and Windows 2003

The Win2K XP DeskLock tool is included on the RSView32 Resources CD, 
and on the RSView32 Tools menu (on the Start menu, select Programs, 
Rockwell Software, RSView32 Tools, and then the tool for your operating 
system).

This tool can have far-reaching effects on your operating system. The 
DeskLock tool replaces the standard Windows Vista, Windows XP, Windows 
2000 and Windows 2003 logon and desktop with a customized desktop. The 
desktop is intended to prevent operators from having access to operating 
system functions such as restarting Windows or shutting down tasks.

Before using the DeskLock tool, read the DeskLock Help file completely. 

Check all these
boxes to disable

access to the
Project Manager

and to disable the
Windows shortcut

keys.
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8 Using the RSView32 
Object Model and VBA

About the RSView32 Object Model and VBA
The RSView32™ Object Model and Microsoft® Visual Basic® for Applications 
(VBA) provide a complete development environment for customizing and 
extending the capabilities of RSView32.

For example, use the RSView32 Object Model and VBA to:

 create code (VBA subroutines) that does conditional branching

 tie RSView32 data to other third-party applications such as Microsoft 
Access or Microsoft SQL Server

 control RSView32 from within a VBA subroutine by issuing RSView32 
commands

To customize and extend the capabilities of RSView32, use the:

VBA integrated development environment. The Microsoft Visual Basic for 
Applications integrated development environment (IDE). Use the IDE to 
create, run, and debug VBA subroutines, and then call these subroutines from 
within RSView32.

RSView32 Object Model. A group of objects that represent features of 
RSView32. By creating VBA code that interacts with the RSView32 objects, 
you can manipulate RSView32 and automate processes.
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How RSView32 uses VBA code
RSView32 uses the term “code” to refer to a VBA subroutine. You can run 
VBA code from anywhere you can run an RSView32 command. For example, 
in the RSView32 Events editor, create an event to run VBA code when an 
alarm occurs, or in the RSView32 Graphic Display editor, create a button that 
runs VBA code when the button is selected.
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The VBA integrated development environment
RSView32 includes Microsoft Visual Basic for Applications. Use the VBA 
integrated development environment (IDE) to create, test, and debug VBA 
subroutines, and then run these subroutines from within RSView32.

This chapter provides a brief description of the IDE but does not include 
detailed information about VBA—it is assumed that you are familiar with the 
VBA environment and programming language. This chapter highlights aspects 
of VBA that are unique to RSView32 and describes how to use VBA from 
within RSView32. For information about how to access VBA information, see 
“Using VBA Help” on page 96.

Opening the IDE window
To open the VBA IDE:

1. In the RSView32 Project Manager, open the Logic and Control folder.

2. Open the VBA IDE by doing one of the following:

 double-click Visual Basic Editor

 right-click Visual Basic Editor, and then click Show
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Parts of the IDE window
The illustration below shows the main parts of the IDE window. Each part is 
then described in more detail.

Project Explorer Window

When you start the Visual Basic Editor for the first time, it creates a VBA 
project with the same name as the RSView32 project. This project contains an 
RSView32 Objects folder, which contains an object called ThisProject, that 
represents all the subroutines written for this VBA project. The object can 
contain any number of subroutines, and these subroutines are visible from 
within the RSView32 Command Wizard.

You can create additional VBA objects and user forms, but these are not 
directly accessible from within RSView32. To use the subroutines in these 
objects and to use the user forms, you must call them from subroutines that 
exist in the VBA project object, ThisProject.

Project Explorer
Window

Properties
Window

Subroutine or
Code Window
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Properties Window

This window lists the property settings for the user forms and the objects on 
those forms. You cannot call forms directly from RSView32. To use a form, 
call the form from a subroutine in the VBA project object, ThisProject.

Subroutine or Code Window

This window is where you write and edit your VBA subroutines. When you are 
creating VBA code that you want to call from within RSView32, be sure the 
project in the VBA code window is ThisProject. The title bar of the code 
window displays the path and name of the project that is open.

Quick Start steps
There are only two main steps to using the RSView32 Object Model and VBA. 
These are:

Step 1    Create your VBA code
Using the Visual Basic programming language, create subroutines in the code 
window for ThisProject. Create subroutines that work with the RSView32 
objects.

For details, see VBA Help. For information about accessing Help for VBA, see 
“Using VBA Help” on page 96.

Step 2    Call your VBA code from within RSView32
In RSView32, call the subroutines in ThisProject to trigger actions in response 
to events. To call a subroutine, issue the RSView32 VbaExec <subroutine name> 
command from a macro, an Action field, or a command line.

For details, see “Running VBA code” on page 87.
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What is a subroutine?
A subroutine is RSView32’s term for a Visual Basic subroutine. When you start 
the Visual Basic Editor, an object called ThisProject is created in the Project 
Explorer Window. This object can contain any number of subroutines and 
these subroutines can be called directly from RSView32. The subroutines you 
create can use other VBA subroutines, functions, user forms, classes, and 
modules.

When to use VBA code instead of an RSView32 
macro
With an RSView32 macro, you can create a list of RSView32 commands that 
will run in response to an action. VBA code allows you to do much more. For 
example, with VBA code you can:

 create conditional logic

 perform operations other than executing commands, such as adding tags to 
the RSView32 database

 reference third-party object models such as the Microsoft Access database 
model

 use VBA user forms that contain native VB and ActiveX® controls

A macro, however, is still useful. When all you need is to issue a series of 
RSView32 commands, a macro is the most efficient way to do this.

For VBA code examples, see Help for the Object Browser. For information 
about accessing Help for the Object Browser, see “Opening Help from the 
Object Browser” on page 94.
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Running VBA code
To run VBA code, issue the VBAExec <subroutine name> command. Use this 
command in any of the following places:

 in a field that requires you to enter an action. For example, use the 
VBAExec command in the Action field of the button object so when a user 
selects the button, VBA code runs.

 in a macro

 in a command line

The syntax for the command is:

VBAExec <subroutine name> [parameter 1], [parameter 2] 

where

subroutine name—is the name of any subroutine in the ThisProject object. The 
subroutine name is not case sensitive. 

parameter—is any parameter that a particular subroutine requires. Separate 
parameters with commas. The parameter can be of any data type, except 
Object.

VBA code can also be triggered by an event from an Activity, Tag, or Tags 
object.

How RSView32 runs VBA code
VBA subroutines run on a first-in, first-out basis. Each subroutine runs to 
completion before the next subroutine is started. For that reason, do not create 
subroutines that wait for user input before proceeding because if a user does 
not respond, all processing of subroutines stops. For example, if you create a 
dialog box that requires user input and no one responds to that dialog box, all 
processing of subroutines stops until the user input is received (although 
RSView32 continues to run normally).

If the subroutine you are running contains events, they continue to be fired, 
even after the subroutine has run. To stop events from firing, you must set the 
value of the event variable to Nothing before exiting the subroutine. See Help 
for an example. To locate the Help topic, on the Contents tab of the RSView32 
Help dialog box, double-click RSView32 Object Model, double-click 
Examples, and then double-click Tag Events.
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Viewing VBA subroutines
VBA subroutines you create are listed in the RSView32 Command Wizard. 
This list of subroutines is not visible anywhere else in RSView32.

To view the list of subroutines:

1. Open the Command Wizard by doing any one of the following:

 double-click in an Action field or, in the Macro editor, double-click 
anywhere in the editor

 click the … button beside an Action field or any field requiring an 
RSView32 command

 click Commands on the Edit menu in the Command Line, Security 
Codes editor, Events editor, and Macro editor

2. In the Command Wizard, click Logic and Control, click Visual Basic 
Editor, click Runtime, and then click VbaExec.

3. In the Command Wizard window, click Next. This will take you to Step 2 
of the Wizard where you’ll be able to see the list of subroutines in the 
Subroutine list.

Scroll through
this list to see the

subroutines in
the project.
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Opening the VBA IDE for editing
You can open the VBA IDE for editing by issuing the VbaEdit [subroutine name] 
command. Like the VBAExec command, you can enter this command in any 
Action field, in a macro, and in a command line.

The syntax for the command is:

VbaEdit [subroutine name]

where subroutine name is the name of any VBA subroutine in the project. If you 
do not specify a subroutine name, the VBA IDE opens at the first subroutine. 
If you specify a subroutine name, the VBA IDE opens with the cursor at the 
specified Sub statement. The subroutine name is not case sensitive.

You can also open the VBA IDE by double-clicking Visual Basic Editor in the 
Logic and Control folder.

The RSView32 Object Model
The RSView32 Object Model contains OLE automation objects that represent 
RSView32 features. Using these objects, you can interact with an RSView32 
project by running one of the subroutines you have created.

The RSView32 Object Model contains the following objects:

Activity. This object represents the RSView32 Activity Log. Use this object to 
log activities to the RSView32 activity log file and, if RSView32 is set up to do 
so, to the activity bar or printer.

AnalogTagAlarmCfg. Use this object to read and write an analog tag’s alarm 
configuration information.

AlarmThreshold. This object represents one of the eight alarm thresholds for 
an analog tag. Use this object to read and write an analog tag’s alarm threshold 
configuration information.

AlarmThresholds. This object represents all of the available alarm thresholds 
for an analog tag. Use this object to read and write an analog tag’s alarm 
threshold configuration information.

Application. This object represents the RSView32 application. Use this object 
to get information about the RSView32 application. 

Channel. This object represents an RSView32 channel. Use this object to read 
and write a channel's configuration information.
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Channels. This object represents all of the available channels. Use this object 
to get a Channel object.

Command. This object represents the RSView32 command server. Use this 
object to issue an RSView32 command.

DataLog. This object represents the RSView32 data log system. Use this object 
to access the RSView32 data log system.

DataLogModel. This object represents a data log model in your project. Use this 
object to add records, access files for the data log model, read records, and write 
to records.

DataLogModelCfg. Use this object to configure a data log model in your 
project.

DataLogModels. This object represents all of the data log models in your 
project. Use this object to add a new model, copy an existing model, get a 
model, and remove a model.

DataLogNarrowRecord. This object represents one record of a narrow-format 
data log model. Use this object to manage the tag information (value, status, 
and name) for the record and to share data with a DataLogWideRecord object. 

DataLogNarrowRecords. This object represents all of the 
DataLogNarrowRecord objects in a data log model. Use this object to get a 
DataLogNarrowRecord object.

DataLogTagValue. This object represents the Tag Name, Value and Status 
information for a data log tag or record. A wide format database record 
(DataLogWideRecord) has a collection of DataLogTagValue objects for each 
record. The narrow format database record (DataLogNarrowRecord) has only 
one DataLogTagValue object for each record.

DataLogTagValues. This object represents all of the DataLogTagValue objects 
in a wide data log record. Use this object to maintain a collection of data log 
value objects (column pairs of value/status for a given tag) in a wide format 
database record.

DataLogWideRecord. This object represents one record of a wide-format data 
log model. Use this object to manage the tag information (value, status, and 
name) for the record.

DataLogWideRecords. This object represents all of the DataLogWideRecord 
objects in your model. Use this object to get a DataLogWideRecord object.
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DigitalTagAlarmCfg. Use this object to read and write a digital tag’s alarm 
configuration information.

Folder. This object represents a folder in the RSView32 tag database. Use this 
object to navigate to other folders or tags in the tag database.

Folders. This object represents all of the folders contained in a folder. Use this 
object to navigate to other folders. You can create and delete folders using this 
collection.

Node. This object represents an RSView32 node. Use this object to read and 
write a node’s configuration information.

Nodes. This object represents all of the configured nodes. Use this object to get 
a Node object. You can create and delete nodes using this collection.

ODBCAdministrator. Use this object to list the available ODBC data sources, 
and to create and validate tables within an existing data source.

Project. Use this object to retrieve information about the currently-loaded 
RSView32 project and to access other RSView32 objects.

Security. Use this object to retrieve security information about the current 
user, or to change the current user (that is, to log the current user out, and to 
log another user in).

Tag. This object represents an RSView32 tag. Use this object to read and write 
a tag’s value, and read and write tag configuration information.

TagDb. This object represents the RSView32 tag database. Use this object to 
create and delete RSView32 tags; to create, delete, and duplicate folders, and to 
get or query for Tag objects.

Tags. This object represents a group of tags. Use this object to work with tags 
as a collection.

For detailed information about the properties, methods, and events of these 
objects, see Help for the Object Browser. For information about accessing 
Help for the Object Browser, see “Opening Help from the Object Browser” 
on page 94.
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Global object variables
A global object variable is a predefined object that is available, for convenience, 
to all subroutines. RSView32 creates these objects when it creates a VBA 
project. Use these objects as you would any other RSView32 object.

The following global object variables are available:

 gActivity

 gChannels

 gCommand

 gDataLog

 gNodes

 gODBCAdministrator

 gProject

 gSecurity

 gTagDb

Viewing the objects
Use the Object Browser to view the RSView32 objects in the VBA IDE.

To open the Object Browser, do one of the following:

 right-click anywhere in the Code window, and then click Object Browser on 
the popup menu

 on the View menu, click Object Browser

 press F2
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To view the global object variables, select RSView32 in the first list.

Getting Help on RSView32 objects
RSView32 contains Help for every RSView32 object, including a detailed 
description of the object’s properties, methods, and events. To open Help, 
select an item in the Object Browser, and then press F1or the ? key on the 
keyboard.

Select RSView32
to display only

RSView32 objects.

Select globals to
view all RSView32

constants.

Select any object
to view its

properties,
methods, and

events.
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Opening Help from the Object Browser
To open Help from the Object Browser:

1. Open the Object Browser.

2. In the list at the top of the window, select RSView32.

3. Under Classes or Members, highlight an item and then press F1 or the ? 
key on the keyboard. 

To view the contents for the entire Help file for the RSView32 Object Model:

1. Follow the steps above to open a Help topic.

2. In the Help window, click Help Topics.
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Opening Help from the Code Window
To open Help from the Code Window, in a line of code, highlight an RSView32 
object name or highlight an RSView32 object’s property or method, and then 
press F1.

Opening Help from the RSView32 Help Contents 
window
To open VBA Code Help from RSView32 Help:

1. On the RSView32 menu bar, click Help, and then click Contents.

2. In the Contents window, double-click VBA Code for an overview, or 
double-click RSView32 Object Model for details about the objects.
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Using VBA Help
VBA comes with its own Help. To access this Help, do any one of the 
following:

 click Help on the toolbar, and then click a menu item

 in any area of the IDE, press F1

VBA documentation
If you’re new to Visual Basic, you might want to look at the following Microsoft 
publications:

 Visual Basic Getting Started

 Visual Basic Programmers Guide
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9 Planning a project

The planning process
A well-designed project requires planning. To help you plan, this chapter 
provides guidelines for:

 understanding the process you’re automating

 collecting data

 designing a database

 designing graphic displays

 using trends

 designing a secure system

Understanding the process
Gather information from a variety of sources so you have a complete and 
detailed understanding of the process you’re automating.

Specifically, you should:

 talk to operators and other experts who are going to use the system. Find 
out what information they need to optimize plant operations.

 talk to management and MIS (Management Information Systems) staff to 
find out what information they need to support planning decisions

 break up each section of the process into its constituent parts

 determine what type of communications you’ll be using—direct driver, 
OPC®, or DDE communications

 determine which process variables need to be accessed and identify their 
locations in the programmable controllers



98  n   Getting Results with RSView32 

Collecting data
When planning data collection, design your system so only essential data is 
collected. Limiting data collection is important because collection activities 
require substantial processing power and generate a lot of traffic on the 
communication channel or network.

Keep data collection requirements in mind when designing the layout of the 
programmable controller data tables and the tag database. Ideally, tag addresses 
should reference contiguous blocks of programmable controller data tables to 
reduce highway traffic and optimize system response.

Designing a database
Take the time to plan your tag database. A good design helps reduce the time 
required for maintenance and can improve programmable controller-to-
RSView32 response time.

Collect information
Before you begin creating the database, collect the following information:

 flowcharts of your processes (or process and instrument diagrams)

 list of programmable controller data table or register addresses your project 
will be accessing

 alarm requirements (for more detail, see “Planning alarms” below)

Organize tags
Before creating tags:

 develop naming conventions for tags, choosing names that are familiar and 
logical to everyone. This makes troubleshooting easier.

 group related tags

Group tags in the way that makes most sense for your application. For 
example, group all similar devices or group related areas of the plant floor.

When creating tags, place related tags into folders. For greater organization, 
nest folders. 
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Planning alarms
Before configuring alarms, plan:

 what conditions will trigger alarms

 how operators will be notified of those alarms

 what information you want alarm messages to contain

 what actions will occur in response to those alarms

 which alarms will require additional actions that you can supply using a 
macro

Planning graphic displays
When planning displays, determine the best way for users to navigate through 
your displays and develop a template to establish a common look and feel for 
your displays.

Develop a hierarchy of displays
A hierarchy is a series of graphic displays that provide progressively more detail 
as users move through them. A hierarchy should meet the needs of the various 
users, including managers, supervisors, and operators.

Well-organized graphic displays present information clearly and consistently 
and guide users through the system. Before designing individual graphic 
displays, plan an overall display hierarchy and plan how users will navigate 
through the hierarchy.

Create a template to ensure consistency
It is possible to keep a consistent appearance among all the displays in a project 
by presenting the same pieces of information in the same place on each display. 
To ensure uniformity, develop a display with common elements that acts as a 
template. Each time you develop a new display, start with a copy of the 
template.



100  n   Getting Results with RSView32 

For example, the template could contain:

 company logo

 title

 date and time

 navigational buttons

When designing displays, practicing good visual design principles helps users 
and increases their efficiency. Aim for these important design principles:

Consistency

 Be consistent with your use of symbols and color.

 Be consistent with button labels and button placement.

When you design several displays, place the same kinds of buttons in the 
same positions. For example, if you have a Start button in a certain position 
in one display, don’t put a Stop button in the same position in the next 
display.

Clarity

 Use symbols that are easily recognizable. For example, use the conventional 
ISA symbols for tanks and valves.

 Don’t overload the screen with information.

 Use standard, clear terminology, and avoid abbreviations or acronyms that 
the user might not understand.

 Use colors with recognizable meanings. For example, in North America the 
colors red and green often mean stop and start. Keep color meanings 
consistent by assigning red only to Stop buttons, and green only to Start 
buttons.

Some people are color blind to red and green so don’t rely on color alone 
to establish meaning. 

 Use high contrast color combinations, such as yellow on blue.
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Usability

 If you’re designing for a touch screen, don’t place important buttons where 
they’ll be blocked by a pop-up window. The user can’t press a covered 
button. Also, ensure the button is large enough for users to touch easily.

 Ensure there is always a clear way to move between displays.

Using trends
When planning trends, consider how they will be used. For example, will the 
trend be used to:

 analyze process trends

 monitor production efficiency

 archive process variables to ensure compliance with government 
regulations

Based on such considerations, you can determine:

 which tags need to be plotted on the same trend

 which tags need to be logged by using a historical trend

Designing a secure system
When deciding on your security requirements, consider whether to:

 restrict access to every project component to prevent accidental changes or 
is limited access enough

 restrict access to certain plant areas

 have everyone log on

 design your system to meet the security standards required for US 
Government 21 CFR Part 11 compliance

Based on these considerations, you can set up security for individual users or 
groups of users. For example, you might want to set up groups of users, such 
as a manager group and a worker group.
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Customizing the system, and integrating with other 
applications

Automating application configuration
When planning your application, determine which routine maintenance 
activities you could automate using the RSView32 Object Model with Visual 
Basic® or Visual Basic for Applications (VBA). For example, you might want 
to have RSView32 generate tags automatically, allowing you to add similar 
product lines to your plant quickly and easily.

Using data with other applications
If you regularly require RSView32 data for use in programs such as Microsoft® 
Excel, or PowerPoint, consider using VBA to extract the data from RSView32 
automatically.

Customizing the system
Adding alarm events

You can write your own alarm detection algorithms using PLC logic, Visual 
Basic or VBA, and you can then create events in RSView32 to respond to the 
algorithms.

Validating operator input

To validate operator input, use the RSView32 Object Model with Visual Basic 
or VBA. In Visual Basic or VBA, create your own pop-up dialog boxes for data 
entry. Use Visual Basic or VBA logic to validate the operator’s input, for 
example to ensure that the value an operator enters for a tag falls within 10% 
of the value of another tag.

Another option is to use the electronic signature button, which allows you to 
specify a range of values for operator input. You can also set up the button so 
that the operator’s data must be approved by a supervisor before the button’s 
action is initiated. You can use the button to initiate tag writes and to run 
commands.

Designing intuitive graphic displays

Use the RSView32 Object Model to populate VBA form objects with data, for 
use in graphic displays. For example, use list boxes or combo boxes in graphic 
displays to allow operators to select options such as recipe items.
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10Getting the information 
you need

Using RSView32 Help
RSView32 Help provides step-by-step procedures and reference information 
for working with all the features in RSView32. To open Help while RSView32 
is running:

 click the Help button on any window

 on the RSView32 menu bar, click Help, and then click Contents

 press the F1 key
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Viewing the Help contents
For an overview of RSView32 Help, click the Contents tab. 

To open a book, 
double-click the book.

 To go to a topic, click 
the topic.
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Using the index
The Help index is similar to an index in a book, listing keywords for topics in 
Help. To see the index, click the Index tab.

As you type a
word here, index
entries are listed

below.

To go to a topic,
double-click it

here or click
Display.

If the index entry
refers to more

than one topic,
the Topics Found
box opens. Select

a topic and
double-click it, or

click Display.
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Finding words or topics
To search the entire text of the Help, click the Search tab. Type in the word or 
words to search for and click List Topics.

To get Help on using the Search tab, right-click a field, and then click What’s 
This?

Scroll through
the list to find the

term you’re
looking for.

When you find
the term, double-

click it to go to
that topic, or click

Display.
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Using the RSView32 online user’s guides
The complete RSView32 User’s Guide, RSView32 Runtime User’s Guide, and 
RSView32 Getting Results manuals are included on the RSView32 CD-ROM with 
the Adobe® Acrobat® Reader® software for viewing the guides. The RSView32 
User’s Guide and RSView32 Runtime User’s Guide provide more detail about the 
topics presented in this Getting Results manual. You can print all or part of the 
guides, and you can copy text and graphics from the guides and paste them into 
other documents.

Viewing the guides
If you installed the user’s guides when you installed RSView32™, you can access 
them by clicking Help, Online Books, and then by clicking either Getting 
Results, or Users Guide.

If you are using RSView32 Runtime, the Online Books menu will show 
Runtime Users Guide instead of Users Guide.

If you installed the user’s guides when you installed RSView32, you will also 
have an icon for them in the Rockwell Software group.

If you did not install the guides, you can view them from the CD-ROM.

To view the 
RSView32 online 
books, click one of 
these items.

To view the 
RSView32 user’s 
guides, click this 
item.



108  n   Getting Results with RSView32 

To view the user’s guides from the CD-ROM

1. Insert the RSView32 CD-ROM into your CD-ROM drive. The CD-ROM 
should start running automatically.

If the CD-ROM does not start automatically, run D:\SETUP.EXE where D is 
the drive containing the CD-ROM.

2. In the RSView32 window, click the View the RSView32 User’s Guides 
button.

Moving around in the user’s guides
Use any of the following methods to move through the user’s guides:

 click a chapter bookmark on the left side of the window

 click a button on the toolbar. Each button has a tooltip that tells you the 
action the button will perform

 click the button at the bottom of the window and, when the Go To dialog 
box opens, specify the page you’d like to go to

 click the scroll bar button on the right side of the window. When you click 
the button, the page number appears



Getting the information you need   n  109

Zooming in and out
Use any of the following methods to zoom in and out of pages:

 click the Zoom tool on the toolbar to change the pointer to the Zoom 
pointer. To zoom in on a particular paragraph or graphic, click the Zoom 
pointer anywhere on the page.

 click a button on the toolbar. Each button has a tooltip that tells you the 
action the button will perform.

 click the button on the bottom of the window and then specify a zoom ratio

Finding information
You can search the user’s guide for a particular word or phrase.

To find a word or phrase

1. Do one of the following:

 on the toolbar, click the Find tool 

 on the Tools menu, click Find

2. In the Find dialog box, type the word or phrase you want, and then click 
Find.

The word or phrase is highlighted in the text. To find another instance of 
the word or phrase, click Find Again on the Tools menu.

Find tool
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Printing pages
You can print selected text, single pages, or an entire guide.

To print selected text

1. On the File menu, click Print Setup, then select and set up the printer you 
will use.

2. Do one of the following:

 on the toolbar, click the text selection tool, and then select the text you 
want to copy

 on the Tools menu, click Select Text, and then select the text you want 
to copy

3. On the File menu, click Print.

4. In the Print dialog box, ensure the correct printer is selected, click 
Selection, and then click OK.

To print one or more pages

1. On the File menu, click Print Setup to select and set up the printer you will 
use.

2. On the File menu, click Print.

3. In the Print dialog box, ensure the correct printer is selected, click Current 
Page or specify Start and End pages, and then click OK.

Using the online guide for the reader
For more information about the Adobe Acrobat Reader, see the Adobe 
Acrobat online guide. To open the online guide while Adobe Acrobat Reader 
is running, click Help on the menu bar and then click Reader Online Guide.

Text selection 
tool
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Technical support
If you have a question about RSView32, please consult this guide, the 
RSView32 Help, or the RSView32 online user’s guides. Or, click Help, 
Rockwell Software on the Web, and then click the name of the web page you 
want to view. To use Rockwell Software on the Web, you must have a web 
browser installed on your computer and a current internet connection.

If you can’t find the answers, contact Rockwell Software Technical Support:

Telephone 440-646-3434

Internet support www.rockwellsoftware.com or

www.support.rockwellautomation.com

Support staff are available Monday through Friday from 8 A.M. to 5 P.M. 
Eastern time, except on holidays.

When you call
When you call, be at a computer and be prepared to provide the following 
information:

 the product serial number

You can find this number on the Activation disk label, or, on the RSView32 
menu, click Help, and then click About RSView32.

 the product version number

You can find this number online. On the RSView32 menu, click Help, and 
then click About RSView32.

 the type of hardware you are using

 the exact wording of any messages that appeared on your screen

 a description of what happened, what you were doing when the problem 
occurred, and how you tried to solve the problem 

You may also be required to provide information about the RSView32 add-ons 
and updates that are installed on your computer.

1. With the Project Manager window active, click Help, About RSView32.

2. Click Add-ons to view the list of installed add-ons. Click Updates to view 
the list of installed updates.
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Index

Symbols
.BMP format    53
.DBF storage format    74
.DXF format    53
.JPG format    53
.RSV file    26
.WMF format    53

Numerics
21 CFR Part 11 compliance

setting up security for    75, 78

A
Abort command    51
Activating RSView32    5
Activation disk

activation keys    5, 6
ActiveX objects    57
ActiveX Toolbox    58
Activity bar    29, 74

clearing messages on    30
hiding    30
moving    30
resizing    30
showing    30

Activity Log Setup editor    46, 73
Activity Log Viewer    46, 74
Adobe Acrobat Reader    107
AdvanceDDE    43
Alarm Log Setup editor    73
Alarm Log Viewer    74
Alarm summaries, creating    65
Alarms, planning    99
Animation

attaching to objects    61

copying and pasting    62
testing    63

B
Buttons

creating    55
creating actions for    56
duplicating    55

C
Code window

getting help    95
Color

background of displays    52
fill    59
items in alarm summary    65
line    59

Command Wizard    38
Commands

Abort    51
Display    51
in buttons    56
in editors    38
in macros    38
securing    75

Communications
checking    44
DDE    43
direct-driver    41, 42
errors    46
OPC    43
RSLinx    41, 42, 46
troubleshooting    46

Components
adding    36
displaying    35
opening    35
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using in more than one project    36
viewing location of    36

Context menu    32, 37
Control. See Animation
ControlLogix tags, importing    70
ControlView    39

D
Data collection, planning    98
Data Log Setup editor    73
Database Import and Export Wizard    69
DDE

server    44
supported formats    43

Display command    51
Display Settings dialog box    49, 52, 63
Documentation

VBA    96

E
Edit mode    32
Editing VBA code

opening the VBA IDE    89
Editors

hints for working in    37
list of    32

Electronic signatures    75, 78
Events

using    87
Expressions    38

F
File names

for project files    26
length of project name    25
long, for data logging    74
references to    36

G
Global object variables    92
Graphic displays

adding objects to    47

animating    47
background color of    52
closing    51
creating    49
Display Settings dialog box    49, 52, 63
ensuring consistency among    99
including a title bar in    63
opening    51
planning    99
runtime settings for    63
saving    49
securing    75
Size to Main Window at Runtime option    
52, 79
sizing    52
specifying a default    52
testing    63
types of    49

Graphic images, importing    53
Graphic libraries    54

alarm summaries    65
trends    64

H
Help

See also Online Help
Code Window    95
Object Browser    94
online Help    93
technical support    111
using VBA online Help    96

I
IDE    83

opening the VBA IDE for editing    89
using    83

Importing graphic images    53
Installing RSView32

administrator rights    4
installation summary    5
uninstalling    16

Integrated Development Environment. See IDE
Internet support    111
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K
KEPServerEnterprise    43

L
Logging

activities    73
alarms    73
data (tag values)    73
viewing logged information    74

Logix 5000 Tag Import utility    70
Long file names, for data logging    74

M
Macros

using VBA code instead of    86
Macros, creating    38
Memory

adjusting virtual memory    13
Modicon devices    43

N
Node editor    42, 44

O
Object Browser    92

getting help    94
Object Model, RSView32    89
Object Smart Path    61
Object variables. See Global object variables
Objects

ActiveX    57
alarm summaries    65
aligning    60
animating    61
applying color to    59
arranging    60
buttons    55
grouping    60
importing    53
spacing    60
substituting tags in    54
testing animation of    63

trends    64
viewing    92

ODBC storage format    74
Online books    107
Online Help

contents    104
finding words in    106
for Adobe Acrobat    110
index    105
opening    103

Online Help. See Help
Online user’s guides

Adobe Acrobat Reader    107
finding information in    109
help for    110
moving around in    108
printing selections or pages from    110
viewing    107
viewing from the CD-ROM    108

OPC
communications    43
server    44

P
PLC database, importing    70
Project

.RSV file    26
adding components to    36
creating    25
file extensions    26
folders in    26
location of components    26
planning    97

Project Documentor tool    39
Project Manager    25, 29, 31

displaying components in    35
edit mode    32
editors    32
folders    32
run mode    32

Project name
length of    25

Project Transport Wizard    39
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R
Rockwell Software on the Web    111
RSLinx    41, 42, 46
RSView32    1

activating    5
exploring    28
starting    11
system requirements    1
uninstalling    16
Works software    17

RSView32 commands. See Commands
RSView32 Database Import and Export Wizard    

69
RSView32 Object Model

about    89
objects    89

RSView32 Tools    69
ControlView Project Import Wizard    39
Database Import and Export Wizard    69
Logix 5000 Tag Import utility    70
Project Documentor    39
Project Transport Wizard    39
Win2K XP DeskLock tool    80

RSView32 VBA code
quick start    85

RSWho    46
Run mode    32
Running VBA code

from within RSView32    87

S
Scan Class editor    42
Security

electronic signatures    75, 78
planning    101
project-level    75

assigning codes to users    76

securing commands    75

securing graphic displays    75

securing tags    75

system-level    75, 79

disabling Windows shortcut keys    79

setting up displays    79

using the Win2K XP DeskLock tool  
80

Security Codes editor    76
Selection button    37
Siemens devices    43
Signature button    75, 78
SLC database, importing    70
SoftLogix 5    41
Status bar    29

hiding    30
showing    30

T
Tag Browser    44, 68
Tag Database editor    42, 44, 69
Tag monitor    44
Tag substitution    54
Tags

analog    67
creating as needed    68
creating many at once    69
designing the database    98
device    67
digital    67
folders    69
importing    69, 70
memory    67
naming    37, 98
organizing    71, 98
securing    75
string    67
system    67
using in an expression    38

Technical support    111
Title bar in graphic displays    63
Toolbar    28

hiding    30
showing    30

Trends
creating    64
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planning    101
viewing logged data in    74

U
Uninstalling RSView32    16
US Government 21 CFR Part 11 compliance

setting up security for    75, 78
User Accounts editor    76
User’s guides. See Online user’s guides
Using the Integrated Development Environment  

  83
Using VBA code    82

V
VBA code

defined    82, 86
quick start    85
running from within RSView32    87

using instead of macros    86
VBA documentation    96
VBA IDE

opening for editing    89
VBA Integrated Development Environment. See 

VBA IDE
Viewing objects    92
Virtual memory

setting in Windows 2000    13
setting in Windows 2003 and Windows XP    
14
setting in Windows Vista    14

W
Win2K XP DeskLock tool    80
Windows keys, disabling    79
Windows user list    76
World Wide Web    111
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